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Connection Guide

Note: For local printing, you must install the printer software (drivers) before connecting the USB cable.

Installing printer and software for local printing using Windows

1
2
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Launch the drivers CD that shipped with the printer.
Click Install Printer and Software.

Note: Some Windows operating systems require that you have administrative access to install printer
software (drivers) on the computer.

Click Agree to accept the license agreement.
Select Suggested, and then click Next.

The Suggested option is the default installation for local setup. If you need to install utilities, change
settings, or customize device drivers, select Custom. Follow the instructions on the computer screen.

Select Local Attach, and click Finish.

Note: It may take a few minutes for the drivers to completely load.

Close the drivers CD installer application.

Connect the USB cable. Be sure to match the USB symbol on the cable to the USB symbol on the printer.

Note: Only Windows 98 SE, Windows Me, Windows 2000, Windows XP, and Windows Server 2003
operating systems support USB connections. Some UNIX, Linux, and Macintosh computers also
support USB connections. See the computer operating system documentation to see if your system
supports USB.

Plug one end of the printer power cord into the socket at the back of the printer and the other end into a
properly grounded outlet.

Turn on the printer.

Plugging in the USB cable and turning on the printer prompts the Windows operating system to run the plug
and play screens to install the printer as a new hardware device. The installation of printer software (drivers)
done in step 1 should satisfy the plug and play requirements. When plug and play is finished, a printer
object will appear in your Printers folder.

Note: After the printer completes its internal tests, the Ready message indicates that the printer is ready
to receive jobs. If you see a message other than Ready on the display, see the publications CD for
instructions on clearing the message.

Send a test page to print.

Using a parallel or serial cable

For detailed instructions, see the User Guide on the publications CD that shipped with the printer.

Local printing with Mac or UNIX/Linux

For detailed instructions, see the User Guide on the Publications CD that shipped with the printer.
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Installing printer and software for network printing using Windows

1
2
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Make sure the printer is turned off and unplugged.
Connect the printer to a LAN drop or hub using an ethernet cable that is compatible with your network.

Plug one end of the printer power cord into the socket at the back of the printer and the other end into a
properly grounded outlet.

Turn on the printer.

Note: After the printer completes its internal tests, the Ready message indicates that the printer is ready
to receive jobs. If you see a message other than Ready on the display, see the publications CD for
instructions on clearing the message.

Go to a computer on the same network, and launch the drivers CD that shipped with the printer.
Click Install Printer and Software.

Click Agree to accept the license agreement.

Select Suggested, and then click Next.

Select Network Attach, and then click Next.

Select your printer model from the list, and then click Next.

Select your printer port from the list, and then click Finish to complete the installation. A printer object is
created in the Printers folder on the computer.

If your printer port is not listed, click Add Port. Enter the information requested to create a new printer port.
Select the option to create an Enhanced TCP/IP Network Port. Other port options will not give you full
functionality.

Send a test page to print.

Other network cabling options

The following may also be available as network options for the printer. More information is available in the User
Guide on the publications CD that shipped with the printer.

¢ Fiber optic internal print servers
e Ethernet internal print servers
¢ Wireless internal print servers
e Ethernet external print servers
¢ Wireless external print servers

Detailed instructions for installation are shipped with the product.

Network printing using Mac, UNIX/Linux, or NetWare

For information about this support, see the User Guide on the publications CD that shipped with the printer.

You can find some additional information on the drivers CD that shipped with the printer. Launch the drivers CD,
and click View Documentation.
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There are numerous publications available to help you

understand the printer and its functions.

Help Menu pages

There are Help Menu pages resident in the printer.
Select to print each individually, or select Print All

to print all of them.

Menu ltem:

Use it to:

Print All

Print all of the guides

Information Guide

(this page)

Locate additional information

Print Quality Guide

Resolve print quality and
troubleshooting issues

Printing Guide

Load media into the printer

Supplies Guide

Order supplies

Media Guide

See what types of media are
supported by the printer

Print Defects

Determine which part may
be causing a repetitive
defect

Menu Map

View all menus and menu
items available

Connection Guide

Connect the printer as a
local or network printer

Moving Guide

Safely move the printer

Setup sheet

The Setup sheet packaged with the printer provides

information about setting up the printer and its options.

Publications CD

The publications CD which was shipped with your
printer contains a User’s Guide, Setup sheet, Menus
and Messages Guide, and a copy of the Help Menu

pages.

The User’s Guide provides information about loading
media, ordering supplies, troubleshooting, clearing
jams, and removing options. It also includes
administrative support information.
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The Menus and Messages Guide provides information
to change the printer settings. It describes the menus
available, the menu items under each menu, and the
values available.

Lexmark’s Web site

Copies of the User’s Guide, Setup sheet, Menus and
Messages Guide, and Help Menu pages are available
on Lexmark’s Web site at www.lexmark.com.

Drivers CD

The drivers CD which was shipped with your printer
contains the necessary printer drivers to get the printer
up and running. It may also contain printer utilities,
screen fonts, and additional documentation.

Other languages

The User’s Guide, Setup sheet, Menus and Messages
Guide and Help Menu pages are also available in other
languages on the publications CD.
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Media guide
The printer supports the following media sizes. Select custom sizes up to the maximum specified for the Universal
setting.
Legend: v/ — supported X — unsupported
Media size | Dimensions 500-sheet trays Multipurpose 850+1150-sheet
feeder dual input drawer
A3 297 x 420 mm v b 4
(11.7x 16.5in.)
A4 210 x 297 mm v v
(8.27 x 11.7/in.)
A5* 148 x 210 mm v b 4
(5.83x8.27in.)
JIS B4 257 x 364 mm v X
(10.1 x 14.3in.)
JIS B5* 182 x 257 mm v v
(7.17 x10.1in.)
Letter 215.9 x 279.4 mm v v
(8.5x111in.)
Legal 215.9 x 355.6 mm v b 4
(8.5x141in.)
Executive 184.2 x 266.7 mm v v
(7.25x 10.5in.)
Folio 216 x 330 mm v b 4
(8.5x13in.)
Statement 139.7 x 215.9 mm v b
(5.5x8.5in.)
Tabloid 279 x 432 mm v X
(11.0x17.0in.)
Universal** 98.4 x 89.0 mm to v b 4
297.0 x 431.8 mm
(39x3.5in.t0 11.7x17.0in.)
7 % Envelope | 98.4 x 190.5 mm b 4 b 4
(Monarch) (3.875x7.5in.)
Com 10 104.8 x 241.3 mm X b 4
Envelope (412x9.51in.)
DL Envelope | 110 x 220 mm b 4 b 4
(4.33x8.661in.)
C5 Envelope | 162 x 229 mm b 4 b 4
(6.38 x9.01in.)
Other 98.4 x 89.0 mm to X X
Envelope 297.0 x 431.8 mm
(39x3.5in.t0 11.7x17.0in.)

* This size does not appear in the Paper Size menu until Auto Size Sensing is changed. See the User’s Guide for more information.
** This size setting formats the page for 297.0 x 431.8 mm (11.7 x 17.0 in.) unless the size is specified by the software application.
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Storing media

Use the following guidelines for proper media storage. These help avoid media feeding problems and uneven print
quality:

For best results, store media in an environment where the temperature is approximately 21°C (70°F) and
the relative humidity is 40%.

Store cartons of media on a pallet or shelf, rather than directly on the floor.

When storing individual packages of media out of the original carton, make sure they rest on a flat surface
so the edges do not buckle or curl.

Do not place anything on top of the media packages.

Avoiding jams hints

The following hints can help avoid jams:

Use only recommended paper or specialty media (referred to as media).

Do not overload the media sources. Make sure the stack height does not exceed the maximum height
indicated by the load line labels in the sources.

Do not load wrinkled, creased, damp, or curled media.

Flex, fan, and straighten media before you load it.

Do not use media that has been cut or trimmed by hand.

Do not mix media sizes, weights, or types in the same media source.

Make sure the recommended print side is face-up when loading all trays for simplex (single-sided) printing.
Keep media stored in an acceptable environment. See “Storing media”.

Do not remove trays during a print job.

Push all trays in firmly after loading them.

Make sure the guides in the trays are properly positioned for the size of media loaded. Make sure the guides
are not placed too tightly against the stack of media.

Make sure all cables that connect to the printer are correctly attached. See the Setup sheet for more
information.

If a jam occurs, clear the entire media path. See the User’s Guide for information on the media path.
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Menu map

A number of menus are available on the operator panel to make it easy to change printer settings. The following
menu map shows the menus and menu items available. For more information about menu items, see the Menus
and Messages Guide on the publications CD. Some menu items may not be available based on the printer model

or options installed.

Paper Menu Reports Defaults Network/Ports Security
Default Source Menu Settings Page Setup Menu TCP/IP Max Invalid PIN
Paper Size/Type Device Statistics Finishing Menu IPv6 Job Expiration
Configure MP Network Setup Page Quality Menu Standard Network
Substitute Size Network [x] Setup Utilities Menu Network [x]
Paper Texture Page PDF Menu Standard USB
Paper Loading Profiles List PostScript Menu USB [x] H_glg
Custom Types Print Quick Ref PCL Emul Menu Front USB Print All
Universal Setup Netware Setup Page PPDS Menu Parallel Pr!nt_Quallty
Bin Setup Print Fonts HTML Menu Parallel [x] Printing G.wde
Print Directory Image Menu Serial Media Guide
Print Demo Serial [X] Print Defects
Netware Menu Map
AppleTalk Informati.on Gui.de
LexLink Connection Guide
Moving Guide
Understanding the operator panel
The operator panel consists of these items:
* 160 x 64 character liquid crystal display (LCD) capable of showing text and graphics
* Eight buttons (Back, Menu, Stop, Select, <, >, A, and v)
* Indicator light
e USB port
Display panel
Menu Back \ Indicator light
\ \\.
@ |\ D, ©© 0
® 6 6
0%» ° - >
/ @ ®
\J
| ® ° oo
1 7 \ 1 ”
USB port Stop Navigation buttons Select button Numeric pad

For more information on the operator panel, see the User’s Guide on the publications CD.
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Moving the printer

Follow these guidelines to move the printer to another location.

CAUTION: The base printer weighs 49 kg (108 Ib). It requires at least two (2) people to lift it safely. Use the

printer handholds to lift it, and make sure your fingers are not under the printer when you set it down.

CAUTION: Follow these guidelines to avoid injuring yourself or damaging the printer:

Always use at least two people to lift the printer.

Always turn off the printer using the power switch before moving it.

Disconnect the power cord from the wall before disconnecting it from the printer.

Disconnect all cords and cables from the printer before moving it.

Remove all printer options before moving the printer. Place the options in the original packaging.

Note: Damage to the printer caused by improper moving is not covered by the printer warranty.

Moving the printer and options to another location

When the optional 500-sheet trays or the 850+1150-sheet dual input drawer is attached, the printer can be rolled
along a flat surface, as these options have casters on the bottom. However, if the printer must be moved over an
uneven surface, it should first be lifted away from these options prior to moving.

The printer and options can be safely moved to another location by following these precautions:

Keep the printer in an upright position.

Any cart used to move the printer must have a surface able to support the full footprint of the printer. Any
cart used to move the options must have a surface able to support the dimensions of the options.
Severe jarring movements may cause damage to the printer and options, and must be avoided.



Printing guide
Page 1 of 4

Printing guide

Get the most from the printer by properly loading the trays, and setting the types and sizes for media.

Loading paper

General guidelines
* Do not overload the media sources.
* Make sure the stack height does not exceed the maximum height indicated by the labels on the guides.
Overloading may cause jams.

* Never mix media types within a tray.
Loading 500-sheet trays
Do not remove trays while a job prints or while Busy blinks on the operator panel. Doing so may cause a jam.

1 Pull out the tray.
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2 Squeeze the side guide tab, and slide the guide to outside of the tray.

3 Squeeze the front guide tab and slide the guide to the correct position for the size paper you are loading.

4 Flex the sheets back and forth to loosen them, then fan them. Do not fold or crease the paper. Straighten
the edges on a level surface.

Note: For information about loading paper in the short-edge feed position, see the User’s Guide.
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6 Squeeze the side guide tab, and slide the guide until it lightly rests against the edge of the paper.

7 Insert the tray into the printer.

For loading other sources, see “For more information” on page 4.

Setting the Paper Type and Paper Size

After setting the Paper Type and Paper Size to the correct values for the type and size used in the trays, then any
trays containing the same size and type are automatically linked by the printer.

Note: If the size of the media you are loading is the same size of the media previously loaded, do not
change the Paper Size setting.

To change the Paper Size and Paper Type setting:
1 Make sure the printer is on and the Ready message appears.
Press v until v appears beside Paper Menu, and then press v.
Press v until v appears beside Paper Type (Or Paper Size), and then press v .

Press v until v appears beside Tray x Type (Or Tray x Size), and then press v.

a h~ WO DN

Press v to scroll through a list of possible paper types (or sizes) to locate the correct type or size. Make
sure the type or size is highlighted with v beside it, and then press then press v. This saves this setting
as the new user default type or size setting.

The message submitting Selection appears. The printer returns to the Ready state.
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Printing on specialty media

Media is paper, card stock, transparencies, labels, and envelopes. The last four are sometimes referred to as
specialty media. Follow these instructions to print on specialty media.

1 Load the media as specified for the tray being used. See “Loading paper’ on page 1 for help.

2 From the printer operator panel, set the Paper Type and Paper Size according to the media you loaded.
See “Setting the Paper Type and Paper Size” on page 3 for help.

3 From the computer software application, set the paper type, size, and source according to the media you
loaded.

a
b

c
d
e

From a word processor, spreadsheet, browser, or other application, select File > Print.

Click Properties (or Options, Printer, or Setup, depending on the application) to view the printer driver
settings.

Select the tray containing the specialty media from the Form Source list box.
Select the media type (transparencies, envelopes, and so on) from the Media Type list box.
Select the size of the specialty media from the Form Type list box.

4 Click OK, and then send the print job as usual.

For more information

For information on See

Media

Media Guide available in the Help Menu

Loading the multipurpose feeder User’s Guide on the publications CD

Loading the 850+1150-sheet dual input trays

Loading the 2000-sheet high capacity feeder
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Many print quality problems can be solved by replacing a supply or maintenance item that has reached the end
of its intended life. Check the operator panel for a message about a printer consumable. See the User’s Guide
for information about other ways to identify consumables that need to be replaced.

The Quality Menu operator panel options can be adjusted to help improve print quality. For more information
about these menu options, refer to the Menus and Messages Guide on the publications CD.

Menu selection Purpose Values
Print Resolution Defines the number of dots printed per inch 600 dpi
(dpi). 1200 dpi

2400 Image Quality*

Toner Darkness Lightens or darkens printed output and 1-10 8* is the default setting.
conserves toner. Select a lower number to lighten
the printed output or save toner.
Brightness Adjusts the gray value of printed objects. -6—+6 0* is the default setting.
Contrast Adjusts the contrast of printed objects. 0-5 0* is the default setting.

In addition, the Enhance Fine Lines and Gray Correction options can be enabled to improve print quality. These
settings are available on the driver and on the printer Embedded Web Server (EWS) interface. For more
information about these options, refer to the driver help.

Note: When set to Auto, this feature disables
the manual Brightness and Contrast controls.

Driver option Purpose Valuest

Enhance Fine Lines | A selgcti_on to enaplg a p_rint r_node preferable for | On In the driver, enable the check box.
diagrams and flow charts.

Gray Correction Automatically adjusts the contrast Auto* In the driver, enable the check box.
enhancement applied to images. off In the driver, disable the check box.

T Values marked by an asterisk (*) are the factory default settings.
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The information in the following table may help you solve print quality problems. If these suggestions still do not
correct the problem, call for service. You may have a printer part that requires adjustment or replacement.

Problem

Action

Print is too light.

AN

¢ The toner may be low. To utilize the remaining toner, remove the cartridge by gripping the
handles with both hands. With the cartridge arrows pointing downward, shake the print
cartridge back and forth. Reinstall the cartridge and then press e

e Change the Toner Darkness setting in the Quality Menu.

* If you are printing on an uneven print surface, change the Paper Weight and Paper Texture
settings in the Paper Menu.

* Verify the correct print media is being used.

Toner smears or print
comes off the page.

AN
ABC

DEF

¢ If you are printing on an uneven print surface, change the Paper Weight and Paper Texture
settings in the Paper Menu.

» Verify the print media is within the printer specifications. See the User’s Guide for more
details.

If the problem continues, turn the printer off and contact the place you bought your printer.

Toner appears on the back
of the printed page.

Toner is on the transfer roll. To help prevent this, do not load print media that is smaller than
the page size of the job to be printed.

Open and close the printer top front cover to run the printer setup cycle and clean the transfer
roll.

Toner fog or background
shading appears on the

AB

DEF

e Check the print cartridge to make sure it is installed correctly.
* Replace the print cartridge.

Entire page is white.

DN

e Make sure the packaging material is removed from the print cartridge.
e Check the print cartridge to be sure it is installed correctly.

* The toner may be low. To utilize the remaining toner, remove the cartridge by gripping the
handles with both hands. With the cartridge arrows pointing downward, shake the print
cartridge back and forth. Reinstall the cartridge, and then press e
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Problem Action
Streaks appear on the * The toner may be low. To utilize the remaining toner, remove the cartridge by gripping the
page. handles with both hands. With the cartridge arrows pointing downward, shake the print

cartridge back and forth. Reinstall the cartridge and then press T

ﬁBg * |f you are using preprinted forms, make sure the ink can withstand temperatures of 212°C
(414°F).

Printing is too dark. Change the Toner Darkness setting in the Quality Menu. See the Menus and Messages
Guide on the publications CD for more information.
B Note: Macintosh computer users should make sure the lines per inch (lpi) setting is not set

ABC too high in the software application.

Characters have jagged or | Change the Print Resolution setting in the Quality Menu to 600 dpi, 1200 dpi or 2400 Q.
uneven edges Refer to the Menus and Messages Guide on the Publications CD for more settings
information.

¢ If you are using downloaded fonts, verify the fonts are supported by the printer, the host

A B C computer, and the software application.

Part or all of the page is Check the print cartridge to see if it is installed correctly.
printed in black.
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Problem

Action

The job prints, but the top
and side margins are
incorrect.

D

ABC
DEF

* Make sure the Paper Size setting in the Paper Menu is correct.
* Make sure the margins are set correctly in your software application.

Ghost images appear.

* Make sure the Paper Type setting in the Paper Menu is correct.
¢ Replace the photoconductor kit.

Gray background prints

* The Toner Darkness setting may be too dark. Change the Toner Darkness setting in the
Quality Menu. See the Menus and Messages Guide on the publications CD for more
information.

e The toner cartridge may be defective. Replace the toner cartridge.

Repeating defects appear

Either the toner cartridge, the photoconductor kit, or the fuser is defective. See “Print quality
troubleshooting” for more information.

Some of the print is cut off
on the sides, top, or bottom
of the media.

Print is skewed, or
inappropriately slanted.

Move the guides in the tray to the proper positions for the size loaded.

Transparency print quality
is poor.

e Use only transparencies recommended by the printer manufacturer.
¢ Make sure the Paper Type setting in the Paper Menu is set to Transparency.
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Print quality troubleshooting

To help isolate print quality problems, print the Print Quality Test Pages.

Note: A v (check mark) appears to the left of an item to indicate that it is highlighted.
Turn the printer off.

Hold down v and >, and turn the printer on.

The Performing Self Test message appears followed by Config Menu.

Press v until Prt Quality Pgs is highlighted, and then press v.

The pages are formatted. The Printing Quality Test Pages message appears, then the pages print.
The message remains on the operator panel until all the pages print.

After the Print Quality Test Pages print, to exit the Config Menu:

Press v until Exit Config Menu is highlighted, and then press v.

5 The messages Resetting Printer and Performing Self Test appear, and the printer returns to

Ready.

Once the pages print, use the defect spacing chart as follows to correct the print quality problem. To obtain the
defect spacing measurement, count the number of black lines between each print defect.

Measurement

Problem

Solution

Print quality defect repeats at every 6 units.

Photoconductor kit

Replace the photoconductor kit.

Print quality defect repeats at every 15 units.

Photoconductor kit

Replace the photoconductor kit.

Print quality defect repeats at every 7 or 8 units.

Toner cartridge

Replace the toner cartridge.

Print quality defect repeats at every 22 units.

Fuser

Replace the fuser.

If another type of print quality problem exists, see the Troubleshooting chapter in the User’s Guide on the

publications CD.
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Match a set of repeating defects on a print
job to the marks on one of the vertical lines.
The line that best matches the defects on

the print job indicates which particular part

is causing the defect.

For example, the distance
between these two marks
represents a repeating
defect that occurs every
44 mm (1.73in.), which
means the photoconductor
kit needs replacing.
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Change the
photoconductor kit.

44 mm
(1.73in.)

Change the
fuser.

78.5 mm
(3.09in.)

Change the
transfer roller.

58.7 mm
(2.31in.)

If the defect appears on the printed side of a single-sided print
job, change the photoconductor kit.

If the defect appears on the back, change the fuser.

94.2 mm
(3.71in.)
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The following table lists the part numbers for ordering supply items:

Part name Part number
High Yield Toner Cartridge wW84020H
Photoconductor Kit W84030H
Maintenance kit (low voltage) 25A0014
Maintenance kit (high voltage) 25A0015
Staple Cartridge 25A0013
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For information about conserving supplies, see the User’s Guide on the publications CD.




